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PREFACE

The Agile documentation set includes Adobe® Acrobat™ PDF files. The Oracle Technology Network (OTN) Web
site contains the latest versions of the Oracle|Agile PLM PDF files. You can view or download these manuals from
the Web site, or you can ask your Agile administrator if there is an Oracle|Agile Documentation folder available on
your network from which you can access the Oracle|Agile documentation (PDF) files.

To read the PDF files, you must use the free Adobe Acrobat Reader™ version 7.0 or later. This program can be
downloaded from the www.adobe.com.

The Oracle Technology Network (OTN) Web site can be accessed through Help > Manuals in both the Agile Web
Client and the Agile Java Client. If applicable, earlier versions of Oracle|Agile PLM documentation can be found on
the www.agile.com/support.

If you need additional assistance or information, please contact support@agile.com or phone (408) 284-3900 for
assistance.

Before calling Agile Support about a problem with an Oracle|Agile PLM manual, please have ready the full part
number, which is located on the title page.

Readme

Any last-minute information about Oracle|Agile PLM can be found in the Readme file on the Oracle Technology
Network (OTN) Web site.

Agile Training Aids
Go to the Agile Training Web page for more information on Agile Training offerings.



http://www.oracle.com/technology/documentation/index.html
http://www.oracle.com/technology/documentation/index.html
http://www.adobe.com
http://www.oracle.com/technology/documentation/index.html
http://www.agile.com/support
http://www.oracle.com/technology/documentation/index.html
http://www.oracle.com/technology/documentation/index.html
http://training.agile.com
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CHAPTER 1
Introduction to Agile PG&C

This chapter introduces Agile Product Governance & Compliance. It includes the following sections:
About Agile Product Governance & Compliance

a How PG&C Gathers and Manages Compliance Data

a Agile PLM Documentation for PG&C

a Microsoft Excel-based Client

O

About Agile Product Governance & Compliance

Agile Product Governance & Compliance (PG&C) is designed to help manufacturers audit the presence and amount
of regulated substances used in their products, and to demonstrate that they responsibly dispose of, recycle, or re-
use parts containing those substances.

This figure depicts a standard cycle of procurement and manufacturing. Other Agile solutions — Product Cost
Management, Program Execution, Product Collaboration, Product Quality Management — manage areas around the
lower half of the circle. Product Governance and Compliance manages the compliance data-gathering area.

Figure 1-1: Closed-Loop Compliance—Corrective Action Process
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Compliance Regulations

OEM manufacturers are required to take global responsibility to dispose of, recycle, or re-use electronics that
contain hazardous substances. In addition to satisfying FDA regulations and ISO standards, any company that sells
electronics equipment in an international market is subject to the OEM manufacturing regulations of their target
markets.

How PG&C Gathers and Manages Compliance Data

Agile PG&C is a communication vehicle between the compliance manager and suppliers. People who manage the
compliance process at the “buyer” site — compliance managers — must ensure that their company’s products adhere
to government regulations and company policy.

More specifically, compliance managers use PG&C to:

Collect data about materials used to manufacture a product

Analyze those data to determine compliance with re-use, recycling, and restriction targets
Collect compliance information on the various regulations (part-level compliance information)
Collect manufacturing process information on parts

Generate reports to show the level of compliance

0o U U U U0 O

Manage supporting documentation, such as descriptions of current regulations, recovery manifests, disposal
certificates of destruction, supplier compliance surveys, and other customer-specific specifications.

Agile PLM Documentation for PG&C

The Preface of this manual provides the URL to Agile documentation for current releases of Agile PLM.

This manual, Agile PG&»C Supplier Guide, provides information for you to learn to work in Agile Web Client and to
complete your end of the compliance process.

A supplier in the PG&C solution is a company that provides compliance information about parts that are used in a
buyer company’s manufacturing process. The Agile administrator at the buyer company has created Agile users,
including people at your company who will complete declaration requests from the buyer.

The chapters and main topics in this manual are:

0 Chapter 2 - “Providing Compliance Information in the RFI Process”: Requests For Information, PG&C Business
Objects

0 Chapter 3 — “Using Agile Web Client”: Changing Your User Profile

0 Chapter 4 — “Responding to Agile Compliance RFIs”: Filling Out a Declaration, Importing and Exporting
Declarations, Working with Microsoft Excel-based Client

Microsoft Excel-hased Client

You may want to complete declaration requests entirely within the Agile environment, as described in this manual.
It is also possible to complete declarations in other environments by exporting data from and importing data to
Agile. Also, a Microsoft Excel-based Client is another means of simplified compliance fulfillment.

If your company has been configured to use this client, you will need to access it via Agile Web Client the first time.

Note Some companies do not permit their employees to download ActiveX controls to their desktop computers.
Therefore, the Microsoft Excel-based Client may have to be implemented by the IT department of your
company via a “push approach”: this automatically pushes the ActiveX control out to users’ desktops. In
any case, you may need to work with your IT department to integrate the Excel-based Client.
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Chapter 1 Introduction to Agile PG&C

The Microsoft Excel-based Client functionality allows you to open companion spreadsheets in Microsoft Excel,
connect to an Agile PLM system, download information, fill out required information, run local validations and
calculations, and upload the information directly into Agile PG&C.

0 Use Case 1: Using the JGPSSI spreadsheet template, upload information to Agile PG&C after validation.

0 Use Case 2: Using the Agile Excel Integration Framework, you can create Excel-based integration for any of the
declarations; contact your Agile representative.

Minimum Requirements for Microsoft Excel-based Client

Microsoft Excel-based clients for Agile PG&C require the following client-side software. These requirements have
likely been satisfied by the time you are called on to fulfill Agile declarations.

Operating System
0 Windows 2000 Pro SPX or Windows XP Pro SP2

Client Applications
0 Microsoft Excel 2000, Microsoft Excel XP, or Microsoft Excel 2003

0 Microsoft Internet Explorer 5.5 or 6.0

1-3
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CHAPTER 2

Providing Compliance Information in
the RFIl Process

This chapter looks at the Request For Information process and the role of the information provider. It also
describes the kinds of “declaration requests” that an information provider may receive from a buyer.

It includes the following sections:

o Supplier Participation in Agile PG&C
a Requests For Information

a PG&C Business Objects

Supplier Participation in Agile PG&C

As an information provider (“supplier”) to a manufacturer (“buyer”) who is seeking compliance information via
Agile PG&C, this manual is your user handbook.

Your company may or may not actually manufacture specific parts that go into the products of an OEM; in any case,
your company does provide compliance information about parts to this manufacturer.

At the supplier site, information providers use PG&C to complete and sign off on material declarations — the vehicle
of RFIs:

0 Declare compliance with specifications concerning hazardous materials that may originate from its customers
and from government agencies

0 Disclose which hazardous substances are contained in the components and subassemblies it provides.

Requests For Information

The process is called Request For Information (RFI). The declaration workflow is the vehicle for RFIs from your
buyers. A declaration keeps track of the compliance information about substances and materials contained in parts
or part families that are named in the declaration.

The general sequence of the RFI process is:
1 Identify parts and part families for which compliance data is required.

2 Identify people within the company (for parts) and suppliers (for manufacturer parts) who can provide
compliance data.

3 Create declarations for parts, manufacturer parts, and part families.
4 Route a declaration to an information supplier.

5 Supplier completes the declaration with data and a signoff.

2-1
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6 Compliance data is assessed for completeness and validated for correctness.

7 Reviewed and approved declarations are released, which “publishes” the data across the product record in
Agile PLM.

The RFI process is depicted in the graphic below.

Parts Composition Declaration with

Requests Multiple
Composition Information Supplier
equests

\R‘,

Jriginating
Jrganization

Declaration with Multiple
Campositions Returned to
Jriginator

Part &

FPart B Part C

iCompleted Composition Data
Distributed to Applicable Parts

PG&C User Guide

The Agile PGe&~C User Guide is the manual for working in the Agile PG&C solution on the buyer side. It describes
how to work with the PG&C-specific business classes in Agile PLM 9.2.1 and the compliance process. In some cases,
it could be useful for a supplier user to refer to the User Guide.

Other PG&C Documentation

With information from the Preface, you may be able to access the Agile Documentation website. All manuals are
periodically updated. Getting Started with Agile PLM is most useful as a source of basic information about working
in Agile PLM, with end-user—oriented documentation about attachments, reports, searches, and workflows.

PG&C Business Objects

The PG&C solution offers configurable business objects called Substances, Specifications, Declarations, and Part
Families. Items and Manufacturer Parts (from Agile Product Collaboration) are also integral to the solution.

Note Itis possible that your buyer’s Agile administrator has renamed existing classes and created new subclasses
than those presented in this guide.

Here are brief definitions of the PG&C business objects.
0 Substances — The Substances base class has four kinds of “substance objects”:

+ Substances — a substance is a single chemical element; for example, lead, chromium, or cadmium.
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+ Substance Groups — a group of multiple substances. Substance groups have a base substance that is the
substance the legislation is interested in.

+ Materials — a compound chemical, that is, a substance consisting of multiple substances. An example of a
material is a glue or a resin that can be bought in bulk.

+ Subparts — a subpart is a subunit of a component. Subparts are not numbered and do not expand the BOM.
Suppliers can create subparts as needed.

O Specifications — A specification states compliance criteria that a product is expected to meet or exceed. A
specification can be an internal document issued by the buyer’s company, a supplier’s own internal specification,
or a regulation issued by a government body, such as the European RoHS directive.

0 Itemsand Manufacturer Parts — Items — Parts and Documents — and Manufacturer Parts are the things that are
assembled into products, about which compliance data must be sought from the information supplier.

Important In this manual, the word “part” is used to mean all objects from the Parts, Documents, and Manufacturer
Parts classes. So, the phrase “parts and part families” can be thought of as inclusive of “any kind of part
used in my company’s manufacturing process.”

0 Part Families — Part Family is a subclass from the Part Groups class. A part family is a “container” that tracks
the overall chemical composition for all parts of a particular type. If multiple parts share the same properties —
for example, the same composition — a part family can be defined with those characteristics.

0 Declarations — A declaration is a record of questions posed by a compliance manager to an information supplier
about the supplier itself, its products, or how its products comply with given specifications. Each declaration is
addressed to only one supplier. Upon completion, it contains the supplier’s responses to the questions. The buyer
reviews the supplied information and publishes it to the product record.

Agile PLM 9.2.1 provides seven kinds of declarations:

+ Substance Declarations — The supplier is requested to provide compliance information for each substance
within the specification. Substances in the attached specification are automatically pre-populated to all the
parts before the declaration is sent to the information supplier.

+ Parts Declarations — Receive part level compliance information as well as other composition header level
information (manufacturing parameters).

+ Homogeneous Material Declarations — The supplier is requested to provide a complete BOS breakdown of
the part and provide compliance information at the homogeneous material level.

* JGPSSI Declarations — The supplier is requested to provide compliance information according to the JGP
standard. Agile supports only JGPSSI version 2.02.

* Supplier Declarations of Conformance — A questionnaire to assess supplier compliance with specifications
from customers and government agencies. The survey addresses compliance at a general company level. Can
be used for CSR type declarations.

From five classes in Rel. 9.2, two classes were added to the PG&C Declarations base class to support compliance
work using the IPC forms for substance declarations (IPC 1752-1) and homogeneous materials declarations (IPC
1752-2). These forms are in Adobe PDF format. Adobe Reader 7.0.5 is the minimal requirement; Adobe Reader
7.0.7 is recommended. The website for Adobe Software is www.adobe.com.

+ IPC 1752-1 Declarations — A Joint Industry Guide (JIG) substance composition declaration for electronic
products.

+ IPC 1752-2 Declarations — A homogeneous material composition declaration for electronic products.

Release 9.2.1 only supports draft “Version 10” of the IPC format, not released Version 1.0. The website for the
IPC forms and information about the “1752” standards is www.ipc.org/IPC-175x. No fields are pre-populated
in this declaration.
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CHAPTER 3
Using Agile Web Client

This chapter describes how to get started with Agile Web Client and how to perform essential tasks.
Topics include:

a Introducing Agile Web Client
a Changing Your User Profile

Introducing Agile Web Client

Agile Web Client is opened using only a browser. Web Client is the only client that supports Agile’s Product
Governance & Compliance solution (PG&C). As a supplier, you are generally assigned to “Basic mode,” and your
user interface with Web Client has been streamlined for responding to PG&C declaration requests.

If your work becomes more involved and the buyer firm assigns you one of the “Advanced modes,” you will see the
full user interface of Web Client; in that case you will need to refer to the manual Getting Started with Agile PLM,
perhaps along with other user guides.

Logging In to Web Client

Your buyer company’s compliance manager has issued you a starting URL, along with username (User ID) and
password. If a URL is specified in the documentation or release notes, copy the upper- and lower-case characters
exactly, including the full domain name specified.

To start Web Client:
1 Start your browser.
2 Click the Web Client bookmark, if one exists, or type a URL that follows this pattern:
http://<webserver>.<domainname>.com/Agile/PLMServlet
The Login page appears.
3 Enter your username. Your username is not case-sensitive.

Your username is assigned by your Agile compliance manager; it is likely an abbreviation of your full name. For
example, the name Michael Jones may be abbreviated to MICHAEL] or MJONES.

4 Enter your password. Your password is case-sensitive.
5 Click the Login button. If you make a mistake, click Clear and retype your username and password.

The login process is complete, and the Requests for Information page appears. In the page’s title bar you will see
“Welcome, < Your Name>" (see graphic next page).
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The page is on the Open Requests link, so the table will list any Agile “declaration requests” that have been sent to you.
The other links are described in “Left Pane Links” on page 3-3.

Figure 3-1: Agile Web Client (Basic mode) for PG&C supplier
2 http:/ [jpw2k3-gx300.agile.agilesoft.com - Agile Product Lifec

MNotifications My Profile  Helpw Logout

Requests for Information

g To respond to a Request for Information, click the link in the Action colurnn or click the Number link to open the Request,

Open Requests | Q Find | Show Al

Due Today Selected: 0 of 1 4 4 Page: Il - I af 10 Pl
Due Tomorrow | Murnber | Action | 0 | Description Status Reguested | Completed | Cue Date
Delinguent MDo0o09 Export AXML.., i Open To g 0 04/12/2006
. Supplier 12:00:00 AM
Inactive Requests POT
Rows per page: ISD - I M 4pPage: Il - I of 1 b M

Main Toolbar
You can use the toolbar buttons on the main toolbar to perform the tasks described in the following table.

Table 3-1:  Web Client main toolbar buttons

Button Name Description

Back Takes you to the previous page you viewed in your browser. (It does not, however, undo any
changes you entered in Agile.)

Forward Takes you to the next page forward. It is disabled if you have not gone forward from the page
currently in your browser.
m Refresh You can refresh (update) the information on the visible page.
ﬁ'ﬁ Home Brings you back to the basic RFI page.
Notifications Clicking the link displays a list of your received notifications, alerting you to events in the RFI
process.
My Profile Clicking the link displays the information that defines your “user object,” which governs your

access to Agile declarations. You can click Edit and change any of the editable fields. Click Save
to save these changes or click Cancel to end the operation without changing your profile.

For more information about changing the fields and definitions of the user properties, see
“Changing Your User Profile” on page 3-4.

Help The Help > About Agile command displays version information.
LogOut Lets you exit Web Client.

Q_ Find Find (Run Simple Searches for declarations that match your typed input. For example, if you are in Open
Search) Requests and there are many, you can search and find the one you are looking for.
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Logging Out of Web Client

To log out of Web Client:
1 From the menu bar, click the Logout button.

2 You are returned to the Login page. To exit, close the browser from the upper-right corner.

Printing Declarations

From the Basic Supplier Interface, the system will print the following tabs of a declaration: Cover Page; PageTwo;
PageThree; Parts/Part Groups tabs as well as the corresponding Substances tables; and Specifications.

Left Pane Links
The left pane on the main RFI page has links as follows:

* Open Requests — this is the default link so you generally see a list of all your open declaration requests. If you have
clicked another link, Open Requests appears as a live link.

* Due Today — lists all open declarations whose due date is set for the current calendar day.
+ Due Tomorrow — lists all open declarations whose due date is set for the next calendar day.
* Delinquent — lists all open declarations whose due date is set for the previous calendar day or earlier.

* Inactive Requests — lists all declarations that were submitted to you but that have been closed by your buyer.

Open Declaration Links

When you have opened a declaration request, the left pane changes its links to the following:

* Edit— Click this link to activate editable fields. Change or add values in any of those fields. Click Save to preserve
your changes, or clicke Cancel to end the operation with no changes saved.

* Add Attachments or View Attachments — Click this link to add attachments to the declaration (for example, you may
want to return a spreadsheet file to the buyer). If the declaration already has attachments, the link says View
Attachments, but you can still add attachments by clicking and following the user interface.

+ Submit Declaration — When you have completed providing the requested data on the declaration—and signed off—
clicking this link will send it back to the compliance manager at the buyer firm.

* Print — You may wish to have or distribute a hardcopy of the declaration at the start or when it is completed.
Click this link to bring up a Print dialog.

+ Email Comments — You may have a question for the compliance manager or other information that you want to
quickly distribute. When you click this link, there are two elements to complete. In the Comments field, simply
type your message or question. Click the Send To button to start a wizard to find names.

* When you are ready, click Send to send the comments. Click Cancel to end the operation with no email sent.

Using the Process Extensions

Note that following the actions listed above, other applicable process extensions are displayed. This topic is covered
in “Importing and Exporting Declarations” on page 4-2.
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Changing Your User Profile

Your User Profile is simply the collection of settings that were entered by the Agile administrator when your “user
object” was created. Clicking the link in the main toolbar displays the information contained in your profile, some
of which is simply information (like phone number) and some of which governs your access to Agile declarations
(like Role).

Your user profile is available for you to modify, within constraints set by the administrator. It contains data under
two tabs, General Info or Preferences.
Important Under Preferences, the Response Edit Mode property is set to Basic and should be left on that setting.

If you select one of the other two settings, Advanced Table Edit or Advanced Wizard Edit, when you click Save, you
will be prompted to log out and log back in; you would then log in to Web Client (Advanced mode), where
your capabilities are restricted.

If you do log in to Web Client (Advanced mode), you will have to click the My User Profile link and go to
Response Edit Mode property to change it back to Basic, followed by logging out and logging back in to
Web Client (Basic mode).

If you work frequently with buyer companies and are often required to create declarations, you can be
assigned additional roles and privileges to enable you to work effectively in Web Client (Advanced mode).

You have an opportunity to enter information when you first log in to Web Client. Again, your Agile administrator
determines to what extent you can edit your user profile.

To edit or add information to your user profile:
1 Open your user profile by clicking My Profile.

2 Click the tab on which you want to make changes. For instance, to make changes to the General Info tab, click that
tab.

3 Click the Edit button on that page. Use lists, browse buttons, and text boxes to enter the requested information.

4 When you have finished, click Save. If you wish to cancel your changes, click Cancel. Clicking the other tab (General
Info or Preferences) will also cancel the current Edit operation without saving changes.

5 To verify changes you make to your user profile, it is best to log out of Web Client and log back in.

Note If you will be working primarily in Web Client, check this setting in your user profile: Preferences > System
Preferences > Preferred Client; it should be set to Web Client. Also, Receive Email Notifications should be sent to
Yes. This will ensure that you will receive email notifications in the same client you are working in. If there
is a discrepancy and you are not able to change these properties, see your Agile administrator.

User Properties Defined
Table 3-2 lists and describes the properties common to supplier users in the Agile PLM system.

Table 3-2:  User properties

Property Description (default is underlined)

General Info tab

User ID (username) The user’s Agile PLM login user identification, or username. It must be unique in the Agile PLM
address book. The maximum is 128 characters.

First Name and Last Name | The user’s public name. Neither of the user’s Names fields has to be unique in the system, only the
user’s User ID must be unique.

Status Indicates whether the user is enabled (Active) or disabled (Inactive). Not editable.

Email The user’s valid email address for change notification/routing. Note: If there is not a valid email
address in the Email field, the user will not receive any email notifications.

3-4 Product Governance & Compliance Supplier Guide



Chapter 3

Using Agile Web Client

Table 3-2:  User properties (continued)

Property Description (default is underlined)

Title

The user’s title, for example, Senior Engineer.

Address fields

There are four address fields that are used for informational purposes only: Address (street), City,
and Postal/Zip Code.

Phone number fields

The user’s Business Phone and Mobile Phone numbers (for informational purposes only).

Fax

The user’s fax number (for informational purposes only).

Pager

The user’s pager number (for informational purposes only).

Secondary Email

The user’s valid email address for change notification/routing. The Secondary Email is optional, but
when the field is filled in, the user receives notifications at both email addresses.

Table 3-3:  User properties

Property Description (default is underlined)

General Info tab, continued

Role(s)

The user’s role assignments. This property determines a user’s access to the objects in Agile PLM
from the point of discovery forward.

User Category

Power, Concurrent, or Restricted: you as a supplier are a Restricted user.

Use Login Password for
Approval

Each user has a login password and approval password (used to approve changes).

Allow Escalation
Designation Approval

This setting is editable. If the user has identified one or more designated escalation persons (DEPs),
this setting determines when the DEPs can approve or reject a declaration.

Settings:

After Escalation — The user’s DEP can approve a routable object only after it has been escalated.
Always — The user’s DEP can always approve or reject a routable object.

Sites

Sites are used for distributed manufacturing, but as sites are not supported by PG&C, this is
unlikely to have options.

Authorized Ship-To

Authorized Ship-To is used only by PCM.

Preferences tab

Preferred File Manager

Select from the list of file servers. For best performance, select a file server that is local server for you.

Receive Email Controls whether the user can receive automatically generated email notifications from the system.
Notification Settings = Yes or No
Language English is available with all Agile PLM licenses. Agile PLM includes Japanese or Simplified Chinese,

per your license. Other languages will be made available in the future.

Preferred Date Format

The format in which dates are displayed to the user. Default is MM/dd/yyvy.

Time Zone

The time zone where the user is located.

Preferred Time Format

The format in which times are displayed to the user. The default is hh:mm:ss aaa (aaa = AM or PM).

Preferred Currency

The currency in which prices/costs are displayed to the user. The default is U.S. Dollar.

Number Format

The format in which numbers are displayed to the user.

Preferred Inbox View

Select between Activities, Notifications, and Workflow.

Response Edit Mode

This field should be left set to Basic. The other two settings, Advanced Table Edit and Advanced
Wizard Edit, will take you into the main Web Client, where your capabilities are restricted.

Rows per Table Display The number of rows that appear in the user’s Agile Web Client user interface. The default is 50.
Static Table Headers Set to Yes to carry table headers to additional pages.
Encode Type The types are Western European (ISO), Japanese (Shift JIS), Traditional Chinese (Big 5), Japanese

(EUC), Simplified Chinese (GB2312), and Unicode (UTE-8).
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CHAPTER 4
Responding to Agile Compliance RFIs

This chapter describes how to respond to Agile declaration requests. This chapter includes the following
sections:

a Filling Out a Declaration
a Importing and Exporting Declarations
a  Working with Microsoft Excel-based Client

Filling Out a Declaration

A Request For Information (RFI) is the process that a manufacturing company (the buyer) uses to seek compliance
data from its suppliers. The buyer uses Agile PG&C to create declarations. When the buyer firm creates a declaration,
it specifies a unique declaration name and a single supplier company.

To complete and sign off declarations, contact users for the supplier company have been assigned a role that permits
access to the declarations. The default recipient at the supplier company receives an email of notification. All users
at the supplier company who have been assigned the appropriate role can respond to the declaration. If you have
questions about who in your company has been assigned this role, contact your buyer company.

When you are sent a declaration request, you are responsible for completing it. You must disclose whether or not
any restricted substances are contained in the component or subassembly it lists, and whether those substances
comply with the given specifications.

Process Sequences in Declaration Fulfillment

The following process sequences describe a range of responses to declarations.

Declaration Opened and Completed in Agile Web Client

1 Supplier firm’s default recipient receives email notification from buyer firm’s Compliance Manager requesting
completion of a compliance declaration.

2 Click link within notification and log into Agile Web Client (Basic mode).
3 Clicks Open Requests link and select the particular declaration request.

4 Fill in your responses directly in Web Client. Currently this is possible only for Supplier Declarations of
Conformance.

5 Complete the Sign Off Message.

6 Submit response back to the Compliance Manager.
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Declaration Opened in Web Client and Completed in Microsoft Excel-based Client

1 Supplier firm’s default recipient receives email notification from buyer’s Compliance Manager to complete a
compliance declaration.

2 Click link within notification and log into Agile Web Client (Basic mode).

3 Use the Openin Excel process extension. The declaration opens in (pre-installed) Microsoft Excel-based Client, and
the file is immediately saved to your hard drive in a folder called Material Declaration Requirements.

4 Within Microsoft Excel, enter your responses into the form, and save it.
5 On the Agile menu in the Excel client, choose Submit Response.

6 Complete the Sign Off Message and click OK.

Declaration Opened and Completed in Microsoft Excel-based Client

1 On the Agile menu in the Microsoft Excel-based Client, select from list of open declarations. The spreadsheet is
populated with data from new declaration.

2 Within Microsoft Excel, enter your responses into the form, and save it.
3 On the Agile menu in the Excel client, choose Submit Response.

4 Complete the Sign Off Message and click OK.

Declaration Opened in Web Client and Completed Using Process Extensions

1 Supplier firm’s default recipient receives email notification from buyer’s Compliance Manager to complete a
compliance declaration.

2 Click link within notification and log into Agile PLM via Web Client (Basic mode).

3 Use the Export JGPSSI or Export AXML or Export IPC XML process extension. The declaration request data is exported in
the appropriate format, and you can open the file.

4 Enter your responses into the file, and save it.

5 Use Import JGPSSI or Import AXML or Import IPC XML to import the completed declaration data into Agile PLM.

Note When adding substances to declaration’s <part/PG> Substances table (using Excel integration or process
extensions), only substances and substance group objects need to exist in the Agile system as global objects.
You, the supplier, are free to enter any name for material and subparts in the Substances table.

Importing and Exporting Declarations

“Process extension” is the formal name of items in the Actions menu in declarations (in standard Web Client) or links
in the Actions column of declaration rows (in simplified Web Client). Links in the Actions column enable you to
perform an operation directly without having to go open the declaration itself.

Note Any kind of declaration can use “Open in Excel” as long as an Excel template for that declaration class has
been created. Consult with your buyer firm and the Agile Solutions Delivery representative. Also see
“Working with Microsoft Excel-based Client” on page 4-4.

These are the current process extensions that may be available on declarations. The Agile administrator at the buyer
firm may have elected not to use more than the basic Actions found on most Agile objects.

The following process extensions apply to JGPSSI declarations:

O Open In Excel — This process extension activates the Microsoft Excel-based Client and opens the JGPSSI template
in Excel
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0 Import JGPSSI — This process extension imports data from a text file in JGP Block format for integration with the
JGPSSI Excel template

O Export JGPSSI — This process extension exports data to a text file in JGP Block format for integration with the
JGPSSI Excel template

The following process extensions apply to Homogeneous Materials Declarations, Part Declarations, and Substance
Declarations:

0 Import AXML — “AXML” is Agile XML, an XML representation of Agile's business schema that contains all product
content managed in Agile. You use this process extension to export the declaration information in aXML format.
The declaration can be completed and re-imported into PLM.

O Export AXML — A declaration that was exported using the aXML format and then completed can be imported back
into PLM using this process extension

The following process extensions apply to IPC declarations:
O Import IPC XML — Imports XML data that is used to complete IPC forms
O Export IPC XML — Exports XML data that is used to complete IPC forms

Note It is possible that when you submit data to Agile from Microsoft Excel-based Client, the data may not be
successfully imported at the buyer side. Yet you may have received a notification indicating that
transmission of the data was successful. The notification is triggered by your submitting the data, not by
its successful receipt: the compliance manager may ask you to re-submit the data in these cases.

Exporting PG&C Data

Grouping the possible “export” process extensions:

O JGPSSI declarations use Open in Excel to open the contents of the declaration’s Parts tab in the JGPSSI format
O Export JGPSSI exports the declaration in JGP Blocks format

O Export AXML exports the declaration in aXML format; this can be used with Part Declarations, Substance
Declarations, and Homogeneous Material Declarations

O Export IPC XML exports the declaration in XML format that is used to complete IPC forms.

Importing PG&C Data

Grouping the possible “import” process extensions:

O Import JGPSSI imports a JGP Blocks file (if it was exported via Export JGPSSI) back into the declaration
O Import AXML imports an aXML file (if it was exported via Export AXML) back into the declaration

O Import IPC XML imports an XML file (if it was exported via Export IPC XML) back into the declaration.

Note You cannot perform a JGPSSI Import on a JGP file that was not already modified via the JGPSSI Excel
template. The transformation from JGP to Agile XML fails when there is no extra data in the file.
Importing and Exporting IPC Declarations

This task outlines how you might receive an IPC declaration that was created in Agile at the buyer site. You would
complete the declaration working in the IPC PDF.
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A typical RFI sequence with an IPC declaration:

1 The compliance manager at the buyer site creates an IPC declaration in Agile PLM; this is an instance from one
of Agile’s IPC business classes, IPC 1752-1 Declarations or IPC 1752-2 Declarations. The default workflow for
the declaration is moved to the Open to Supplier status.

2 You, the contact user at the information supplier, log in to Web Client (Basic mode) and see the declaration
name. A link in the declaration row activates the Export IPC XML process extension. (Or, if you click the declaration
name, all available process extensions are displayed as links on the left navigation pane.) An XML file is saved on
your machine.

3 Ifyou have already downloaded the IPC PDF forms from the IPC web site (www.ipc.org/IPC-175x), open the
IPC form in Adobe Acrobat and click Import Data (or File > Form Data > Import Data to Form), then specify the location
of the XML file. The XML-contained data is imported to the PDF form.

4 Enter or modify values in the declaration.

5 When you have completed the form, the data is exported using Export Data (or File > Form Data > Export Data from Form).
The existing XML file is overwritten.

6 Returning to Web Client, use Import IPC XML process extension to import the modified XML data. Then submit
the declaration to the buyer firm.

7 Atthe buyer site, the compliance manager opens the completed declaration in Agile to review for possible release.

Working with Microsoft Excel-based Client

The Microsoft Excel-based Client should be installed, configured, and tested by the buyer company. If you have
problems with the Excel integration in PG&C, contact the compliance manager at the buyer company.

When you first access a declaration via the Microsoft Excel-based Client, a folder is automatically created on your
desktop to store declarations. The folder may be called Material Declaration Requirements. Although you must access the
Client via Agile Web Client the first time, you can subsequently open Microsoft Excel and access declarations
directly.

You may receive a test (JGPSSI) declaration from your buyer company, and you can use the following task to test
whether the Microsoft Excel-based Client for JGPSSI Declarations is working properly.

To test JGPSSI Declarations in Microsoft Excel:
1 Log in to Agile Web Client.

Click the link to the JGPSSI Declaration to open it.

Click Open In Excel; it is in the Actions column.

Microsoft Excel is launched and the file is opened. You are prompted to save the file to a folder on your desktop.
Fill in a one or more fields on the sheet. For example, change the value of the Parts Mass field.

Save the Microsoft Excel file.

~N o o A W N

On the Agile menu in the Excel client, choose Submit Response. The Submit Response window appears. You are
prompted to log in when attempting to submit response from Agile menu in Excel.

8 Type your approval password, and click Submit.

9 Wait while your response is uploaded. After a minute, a message box should appear: “Your response was
successfully submitted for processing.” Click OK.
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Note  When you open a JGPSSI declaration in Microsoft Excel and try to edit one of the cells, you may see the
following error message: “The cell or chart you are trying to change is protected and therefore read-only.
To modify a protected cell or chart, first remove protection using the Unprotect Sheet command (Tools
menu, Protection submenu). You may be prompted for a password.” However, the colored cells of the
JGPSSI template (such as headings) are protected and cannot be edited. You should edit only unshaded
(white) cells.

Note After submit from Excel Integration, it can seem that supplier data has been submitted and declaration has
moved to next status, whereas the server takes awhile to process the data.
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